Release Notes
Kurzweil 3000 Version 12.18
July 5, 2012

WHAT’'S NEW?
12.18 CHANGES AND RESOLVED ISSUES

In All Editions:

Bug fixes only.

THE REMAINDER OF THIS DOCUMENT INCLUDES:

General Installation Notes

Information from Previous V12 Releases, including Support Updates, Product Notes,
Technical Notes, Network User Notes, Standalone and Network Notes

Contacting Kurzweil Educational Systems

GENERAL INSTALLATION NOTES

Version 12 program install and program-related files are on DVD, so you will need a
DVD drive. A downloadable version can also be found on www.kurzweiledu.com/k3win.
Before installing Kurzweil 3000 Version 12 read the Installation Instructions in the
Kurzweil 3000 for Windows Standalone or Network Installation and Administration
Guide.

Version 12 no longer includes filters and converters from Stellent. If you want to keep the
converters, do not uninstall the earlier version of Kurzweil 3000; instead install Version
12 over the previous version.

When installing or uninstalling on computers with Windows XP, Windows Vista, or
Windows 7 you must be logged on as administrator or as a user with administrator
privileges.

The starting point for the Version 12 install is the Setup file in the directory window that
opens when the product DVD is inserted. Double-click that file and follow the prompts.
Whenever installing a combination of Kurzweil 3000 and Kurzweil 1000 (reading system
for the blind), always install the older version first, based on the date on the DVD.

The Trial version can no longer be activated to the full product. For the full product, you
must install from the separate product DVD and register the product.

All documentation is available in PDF format in the Documentation folder on the product
DVD, as well as at http://kurzweiledu.com under the Download Center.
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INFORMATION FROM PREVIOUS V12 RELEASES
12.17 CHANGES AND RESOLVED ISSUES

In All Editions:

e Implementation of BookShare Mashery API.

e Implementation of MSI installer in a single step.

e Flxed issue of Taskbar "Incompatibility Message" for Windows 7 Professional.

e Fixed issue of VPORT Auto-login for Class Management and Class Reporting links.

12.16 CHANGES AND RESOLVED ISSUES

In All Editions:
e Fixed missing usage data in VPORT.

12.15 CHANGES AND RESOLVED ISSUES

In All Editions:
e Fixed issue with Sticky Note and Text Note Delete buttons not working.
e Resolved issue with online search requests causing Kurzweil 3000 to stop working.

In Web License Edition:

e Current Assignment document info page "Up" and "Down" buttons are disabled as they
should not work for the current assignment.

e Fixed issue where licenses would not renew on Macintosh computers running Windows.

Documentation Issues:
e Corrected assorted broken links in PDF files and Help online.
e Added note that creating MP3 audios is not available with Kurzweil 3000 License-to-Go.

12.14 CHANGES AND RESOLVED ISSUES

In All Editions:

¢ Auto Update has been changed. In version 12.14, non-Administrator/restricted users are
no longer offered the auto-updates. In addition, only the last update is displayed in the
Online Update dialog box list for all user types.

e As search for updates can take a bit of time, the Search for Updates dialog box now
includes a message notifying users that the search can be canceled anytime by clicking
the close button on the top right corner.

e Scrolling and state issues, when combining the use of keyboard shortcuts with the use of
the mouse on menus, have been fixed.

e With Speak Button enabled in General Options, certain buttons when selected multiple
times, only play on the first selection. This issue has been fixed.

¢ Resolved issue with Read the Web crashing when encountering Web pages containing
empty frames.

¢ Fixed issue with single-line Bubble Notes allowing multiple-lines of text to be entered.

e Fixed Microsoft’'s Windows Installer presenting a random number to the MSI during
Kurzweil 3000 installation.

¢ Resolved issue with certain Microsoft Word 2010 files failing to open or causing errors in
Kurzweil 3000.

e  With Win7 64bit, Kurzweil 3000 hangs upon right clicking in Column Notes area and
selecting extract from column notes to outline. This has been fixed.
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Fixed issue with MSI not installing silently.

Help now returns searches on phrases beginning with “my,” such as “My Assignment.”
Minor application icon updates.

Minor typo edited in Brainstorm template.

In Web License Edition:

e Fixed issue with completed and accepted assignments not appearing in Past tab.
e Teachers can now open a Student's folder, and save a document to that location.
e Resolved issue with error when using Kurzweil 3000 Web License in Bootcamp.

Documentation Issues:

e Animated gifs requires copying and placing a special file into a directory on the local
computer. Steps for doing this are now included in the documentation.

e Added filename restrictions to Save to the Universal Library dialog box.

e Corrected assorted broken links.

12.13 CHANGES AND RESOLVED ISSUES

In Standalone Edition:
e Error when using New Pronunciation has been fixed.

In All Editions:

e For Windows 7, 64-bit systems for Internet Explorer, the IE Add-on, KESIReaderBHO
Class, should be enabled. If the add-on is disabled, the Read the Web toolbar will not
display. To enable this add-on, go to the Internet Explorer (64-bit) Tools Manage Add-
ons dialog, under Cambium Learning, find the KESIReaderBHO Class row. In its Status
cell, set the value to Enabled, and then Close the dialog.

e Issue with error message displaying when corrupt file is encountered during New
Pronunciation setup. This has been resolved. Now when there is a corrupt file, new good
files are copied over, allowing for new pronunciation updates.

e Updated Online Registration Purchase Year default.

e Resolved issue with error when using Translate for a joined text file.

e Various minor message edits.

In Web License Edition:

e Cross-version authentication no longer exists. Version 12 does not accept firefly logins;
Version 13 does not accept VPort logins.

¢ Resolved issue with coordinator accounts at Rainbow BOE not being able to log in to the
Web License Administrator utility.

e Fixed problem with Sort by Teacher Comments not sorting.

¢ Resolved issue with error upon selecting Teacher Comment icon.

¢ Minor message edits.

Documentation Issues:
e Updated FTP address for the Reduced Ul MSI in the Web License and Network
Installation Guides.

e Kurzweil 3000 product Readmes now send users to the Software Updates page on our
website: http://www.kurzweiledu.com/software-updates.html.
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e Added Word Wrap in Readme in Show New Features at install.
e Extras Folder Readme has been updated.

12.12 INFORMATION
Enhancements in All Editions:
e Automatic checks for software updates upon installation and/or upon launching Kurzweil
3000. Note that it is possible to disable the checks for updates during MSI installation.
e Read the Web screen now allows you to scroll as the program continues to read.

Changes and Resolved Issues in All Editions:

e Copyright date change.

e Release note information within the product (e.g., What's New page in online Help) is
now accessed with a link to the Kurzweil 3000 Software Updates page.

e Arepair message displays upon launching the product if time lock had been unregistered.
Run the repair and launch the product.

¢ Resolved issue with the inability to change Reading Voice when reading MathML
(equations).

o When recording a Voice Note, upon selecting the Cancel button, then selecting No, the
Voice Note box is still cancelled, losing user changes. This has been fixed.

e Resolved error upon selecting OK in the New Pronunciation dialog box.

¢ Resolved issue in New Word List so that dialog box opens larger allowing all information to
be seen when creating Word lists.

e Fixed no help page when clicking the Help button from the Get Picture, Get Definition, Get
Synonym, and Get Human Pronunciation dialog boxes.

e Various fixes in documentation: Quick Reference Guide and Web License Guide missing
reference to Virtual Printer; incorrect x64 installer location in Standalone Guide and Web
License Guide.

e Updated the readme.txt to change the date and remove Firefox executable file.

e Updated Standalone Online Registration Purchase Year default to 2012.

e Updated ftp address for Reduced Ul MSI option to
ftp:/fitp.kurzweiledu.com/pub/K3000UIAction/

Changes and Resolved Issues in Web License Edition:

¢ In the Universal Library, semicolons are no longer valid in file and folder names.

e Fixed issue with Web license not being checked back in on exit.

¢ Resolved various login and access issues for individual students and classes of
students.

¢ Resolved issue with crash upon accessing the license screen.

12.11 INFORMATION

Changes and Resolved Issues in All Editions:

e Updated Google translate.

e Fixed issue with word being masked with black highlighting when double-clicked in the
Homophone Il dialog.

e After using and closing Definition, Synonym or Hyperlink window for a selected word, the
cursor would not return to the selected word in the KES image file. This has been fixed.

e Fixed broken Fill in the Blanks.
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Changes and Resolved Issues in Web License Edition:

Fixed issue with newly created students could not access personal as well as their
school’s Public directories.

Users could not save back to the same .kes document in the Universal Library using
Save options. This has been fixed.

12.10 INFORMATION
Changes and Resolved Issues

Full product in a self-extracting downloadable file from the website.

KESIReader extension causing IE7 and IE 8 to crash.

Multiple issues when extracting highlighted: possible crash; or for extracting text from
large color documents, a large extracted file results containing extra empty rows and if
Spell Check is enabled, the program spell checks the source document.

When using Get Picture/Definition/Synonym/Human Pronunciation, user entry is not
being automatically cleared form the dialog box.

No synonyms available when using a Kurzweil 3000 language option, other than
English.

Print to PDF not printing images in color.

Broken Bookshare site link.

Error when opening sample files.

Error when attempting to configure the LAN Universal Library option to a path other than
C:\.

Link issues in online Help pages.

Known Problem: Typo in Brainstorm Template, although Templates may still appear with
the typo because they are treated as settings, and are not affected by software updates
and product reinstall.

In Web License Edition:

Error upon opening pdf files in Universal Library.

Inability to Enable Kurzweil 3000 licenses in VPort.

Universal Library association not updating with new school enrollment information.
Error when running the Distribution of Student Performance report.

Universal Library inaccessible to Campus, Principal, and Campus Coach users.

Error when viewing results of text-only assignments.

Intermittent loss of access to Universal Library and Assignments system.

When switching from Web-based Universal Library to LAN-based Universal Library, the
Web Universal Library icon continues to be active in the toolbar.

Error when using choosing Class Reporting.

12.09 INFORMATION
Fixed issues:

Kurzweil 3000 crashing when extracting highlighted text.

Auto-scroll Images checkbox setting, when unchecked, was not being saved in user
profile.

When in the Options, Reading area, with 'Speak Buttons' turned on, upon de-selecting
'Read Voice Notes in place’, Kurzweil 3000 responds with an audio message: “Do not
automatically read footnotes when they are reached.”

When selecting Help from the Scan corrections dialog box, the page does not display.
For Get Picture/Definition/Synonym/Human Pronunciation: user text entry is not being
automatically cleared from dialog box.
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12.08 INFORMATION
Fixed problems with setting default Reading Speed in Options not applying.
Fixed an issue with Kurzweil 3000 reading secondary text even though the zone order is
correct.
Various issues were resolved in the Web License Edition as outlined below.
e Errors when using a district level user to set up LAN/Web Universal Library.
e Universal Library options in the File menu not showing and functionality not available for
Campus Users.
e Error message when trying to use certain Assignment features, such as Class
Reporting.
e Error message when trying to open PDF documents from Universal Library.

12.07 INFORMATION
Addition of Classic Literature, a collection of nearly 2000 books, historical documents

selected from the public domain, is now accessible from the Kurzweil 3000 Web License
Edition Universal Library. Find literary classics by authors such as Jane Austen, Fyodor
Dostoyevsky, William Shakespeare and Oscar Wilde. Children’s classics by L. Frank Baum,
Brothers Grimm, Rudyard Kipling and Mark Twain. Classic texts from Aristotle and Plato.
Scientific works such as Albert Einstein’s “Relativity: The Special and General Theory.”
Reference material including world factbooks and famous speeches. Religious text in the
entirety.

12.06 NFORMATION
Updated for FireFox 5

When looking up a definition of a word, the word in the resulting Definition window
contains the question mark character. This encoding problem has been fixed.

12.05 Dutch and French releases only.

12.04 INFORMATION
All Editions:

e Updated Help — The PDF versions of the Web License Guide and the Network
Installation Guide are downloadable from http://www.kurzweiledu.com/product-
quides.html, Kurzweil 3000 Version 12 tab, and Documentation Downloads page. Online
Help has also been updated.

e Updated for FireFox 4, Internet Explorer, and Gutenberg online books.

12.04 CHANGES AND RESOLVED ISSUES
Changes in Web License Edition:

e Upload to Web Universal Library utility now includes batch upload to the District.
Resolved Issues in All Editions:

¢ Running Ranked Spelling for multiple documents produced combined results for all

documents when viewing an individual document’s list. This has been fixed.

e Fixed problem with Word Prediction Word Pairs not working.

e Fixed problem with hyperlinks not pointing to correct bookmarks.

e Fixed problem with Word Lists disappearing.
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12.03 Dutch and French releases only.

12.02 INFORMATION
New in All Editions:

e Updated Help — The PDF version of the Web License Guide is downloadable from
http://www.kurzweiledu.com/product-guides.html, Kurzweil 3000 Version 12 tab, and
Documentation Downloads page.

e New Artwork for the product splash screen.

New in Web License Edition:

e District Library in Web Universal Library structure — A district-level public folder, ideal for
sharing district-wide curriculum files and resources, has been added. The district Library
is the district version of the school’s Public folder. Everyone in the district has Read and
Copy permissions, while Teachers can also create, save, rename, and delete files in it.
Optionally, someone in the district with Teacher or higher user privilege, can create a
Share folder under the district Library allowing students to share files across the district.
Note that no one can copy, rename or delete the Library.

e License Time Out — After 60 minutes of inactivity, a message appears asking if you are
still using the program. If there is no response within 5 minutes, Kurzweil 3000
automatically logs off your account in order to reclaim the license. The only function
available in Kurzweil 3000 is Save so that you can save any work. If there is an
assignment in progress, Kurzweil 3000 automatically saves the work.

e Change User in the File menu is now available for users.

e Users Preferences travel with users from computer to computer. Kurzweil 3000 Web
License system maintains each user’s personal preferences, settings and any feature
that is customizable, including Toolbar sets, Word Lists, OCR Corrections list, and Word
Prediction and Spell Check dictionaries. Upon logging in, Kurzweil 3000 checks for and
uses the latest settings.

Resolved Issues in All Editions:
Reading
¢ In Continuous Reading mode, when Kurzweil 3000 finishes reading a selection of text in
an image page, the cursor jumps to the top of the page and the first word flashes. This
has been fixed.
Brainstorm
¢ In a Brainstorm object containing text, placing the cursor anywhere results in the
insertion point at the beginning of the text. This issue has been resolved.
Outline
¢ When adding a note to any item in Outline view, Kurzweil 3000 set the cursor before the
first main topic. This issue has been resolved.
¢ Fixed program crash when closing Outline view without saving edits made.
¢ Numbering issues resolved include: Numbering from Outline view was not translated in
Brainstorm view, numbers being deleted during Outline creation.
Column Notes
¢ When reading through a multipage text document with Column Notes window open
below, the content in the Column Notes appears in the host document, overwriting text in
the document. This is fixed.
e SAPI5 timing issue which was causing reading to go out of sync in Column Notes when
using the Speak button. This has been fixed.
Application hangs when creating a Hyperlink in Footnotes. This has been resolved.
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File Open and Arrow Keys
e Fixed arrow keys not functioning in file name field when using File Save As for image
documents.
Read the Web
e Fixed issue of Kurzweil 3000 Read the Web message in Internet Explorer remaining
even when Read the Web is not open.
e Fixed error message display upon selecting Scroll Automatically under Read the Web in
the Reading Options dialog.
Spell Check
e Fixed a problem with text not being read in the Spell Check window.
Printing Fill in the Blanks Answers
e When printing Fill in the Blank files, no answers or only some characters in the answers
print out. This has been fixed.
Page Navigation
e When using Read the Web, Hyperlink, or Synonym functions in a multipage document,
page buttons on the page navigation toolbar are grayed out. This has been fixed.
Tools Options Image Color
e With Speak Button option selected, the Tools Options Image colors were not being
spoken. This is fixed.
Human Pronunciation
e Resolved issue with Human Pronunciation from the Toolbar not working for users
without Administrator privilege.
Shortcut Keys
¢ Fixed non-functioning CTRL+R and A key in Zone Editor and Header-Footer Editor.
Taskbar
¢ If you had the Kurzweil Taskbar active, when you install the software update, it is no
longer available. You must re-activate it using the Right Mouse Button menu’s Toolbars
> Kurzweil Taskbar command. When the Kurzweil Taskbar is re-activated, the default
voice will be VW Julie, or the voice you had previously selected.
Language Tags
e Tagging the last word in a page as another language resulted in reading the word in the
set language, but reading the last character in the original language. This has been
fixed.
Field Text
¢ Fixed non-functioning Field Text Edit.
Resolved Issues in Web License Edition:
Universal Library
e Teacher's Universal Library access was restricted to the first school that that teacher
was assigned. Documents could not be saved to the school folders in the Universal
Library for schools beyond that first one. Reassigning the teacher to a different school
resulted in access to only the initial school assigned. This has been fixed. Users with
Teacher privilege can now view classes in any schools across a “campus.”
¢ When selecting a file from File Open from Library, and using the Rename feature, the file
disappears. This is fixed.
Assignments
e The Assignment Name list’s default sort order was alphabetical in descending order,
from Z to A. The default sort order is now alphabetical in ascending order, from A to Z.
You can click again to sort by descending order.
e Flag Sorting in Assignment lists now works, and the default is by highest to lowest
severity.
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e Sort order selection in Assignment lists is maintained from session to session.

e When Word is not installed on a system, saving a .KES document that contains Bubble
Notes or a Brainstorm file in Word .DOC or .DOCX format, then Publishing it results in a
system error. This is fixed.

e Opening a New Response Document from the Student Assignments Menu returns a
system error. This has been fixed.

e Saving a No Response Assignment containing Bubble Notes with answers is resulting in
error messages and loss of edits and answers. Furthermore, closing the document does
not save the answers. This is because any edits or answers made in Bubble Notes in
No-Response documents cannot be saved as the document does not require responses.
There are now new warning messages when you open the No-Response document and
when you try to save or close the file. Note that text that you highlight using the Highlight
pens in a No-Response document does get saved.

e Response Type box (found in New Assignment and Edit/View Assignment dialogs) is no
longer an editable text box, but a list box.

e Fixed issue with Assignment document list not displaying document names when
scrolling.

e Fixed Teacher Comments button not available in Past Assignments view.

¢ In the Student Past Assignment dialog, the Changed Date column header is now called
“Status Change Date,” with the same functionality, i.e., indicates when a teacher has
accepted or rejected an assignment.

Scoring

e Answers to matches in matching questions are being scored incorrectly. This has been
fixed so that each match within a matching item counts as a single question towards the
total number of questions in the assignment.

Resolved Issues in Network Edition:

e Resolved issue with inability to delete a logged on user from the network, and inability to

work on Network Administrator until the user is logged off.

12.01 INFORMATION
SUPPORT UPDATE
e Kurzweil 3000 no longer supports Cartesian Compression. See Technical Notes for
more information.
e Windows 95, Windows 98, Windows ME, Windows NT, and Windows 2000 are no
longer supported for Kurzweil 3000.
e Kurzweil 3000 Version 9 and earlier versions are no longer supported.
e PCX image files are no longer supported.
e Version 12 no longer includes filters and converters from Stellent.

PRODUCT NOTES

e The text-to-speech voices shipped with Kurzweil 3000 have been updated. We are now
shipping NeoSpeech Paul and Julie (English) and NeoSpeech Violetta (Spanish). We
are no longer shipping NeoSpeech Kate, and RealSpeak Javier and Paulina Spanish. If
your system already has VW Kate and you want to continue using it, do not uninstall it
when installing Version 12, otherwise, VW Julie will be the default female voice.

e The Hyperlinks in Bubble Notes feature have been removed and replaced with the
Add/Edit Hyperlinks found on the Tools menu.

e The Read button in the Kurzweil 3000 Taskbar has been changed to the same green
Read arrow that is in the program’s Main toolbar.
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TECHNICAL NOTES
NIMAS

e When opening NIMAS .opf files, Kurzweil 3000 uses a converter which saves them as
.KES files that you can then read. If you choose to keep images when you convert files,
you should be aware that those images will only be visible when read with Kurzweil 3000
Version 12 or above. Earlier versions of Kurzweil 3000 will ignore those images entirely,
and may drop them if editing is done with earlier versions. The same is true if you
convert DAISY 3 documents that have links to images to KES files.

e Some of the underlying components used by the NIMAS converter have size limits - in
particular, one component is limited to a maximum of 32,000 paragraphs. We have not
found a NIMAS file that exceeds that limit yet, but there are likely to be some. If so, they
will not convert properly.

e The NIMAS converter does not support SVG files.

¢ Note also that the NIMAS conversion process can be a bit time-consuming.

KESI Virtual Printer and Internet Explorer

e If you want to use KESI Virtual Printer and have IE in Protected Mode, you must first
disable Protected Mode and Restart before using the Virtual Printer. When you are
finished, re-enable Protected Mode and Restart.

Hidden Audio File Folders

e Audio Output files are automatically placed in the Audio Output shortcut folder on the
user’s desktop. In the event that the shortcut is accidentally removed, the output files
may be found in the Application Data or ProgramData (Windows 7) folder.

¢ If, however, your system has the option, Hidden files, folders, and drives, set to Don’t
Show, the output audio file folder will be hidden. To display hidden files and folders, find
Folder Options and set Show files, folders, and drives.

Audio Spooling

e If AudioSpooler was working when your computer was shut down, you must manually
run AudioSpooler.exe to continue converting after the reboot. You can add a shortcut to
AudioSpooler.exe in your Startup folder if desired. It will exit when finished or if no
conversion work is found.

e The Kurzweil 3000 installation process creates two folders for audio files (Pending Audio
and Output Audio) in Documents and Settings\All Users\Application Data\KESI or under
Program Data in Vista and Windows 7. Limited Users on at least some version of
Windows do not have the ability to write to this folder by default. This means that in order
to use the Create MP3 feature, a Client must be logged on to Windows as a Power User
or higher, or they must be given write access to the "KESI" folder listed above.

Opening Cartesian Compressed Files

e Kurzweil 3000 no longer supports Cartesian compression. If you want to open image-
based .KES files created using Kurzweil 3000 Version 8 or earlier, you will need to use
the UpdateKES utility download from
http://www.kurzweiledu.com/index.php?module=updatekesutility.

NETWORK USER NOTES
License-to-Go
e License-to-Go saves a file to the "All Users\Application Data" or “Program Data” (for
Vista and Windows 7) folder so that it is accessible to anyone who uses the machine.
The actual location of this folder can vary, but it's typically:
e C:\Documents and Settings\All Users\Application Data\
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e Limited Users on at least some version of Windows do not have the ability to write to this
folder by default. This means that in order to use the License-to-Go feature, a Client
must be logged on to Windows as a Power User or higher, or they must be given write
access to the "KESI" subfolder of the folder listed above.

e In order to use License-to-Go, you must also give full access to the following registry key
and all its descendants:

[HKEY_LOCAL_MACHINE\SOFTWARE\KESI]

WEB LICENSE NOTES

e Kurzweil 3000 Automater launch includes user name and password boxes for Web
License Edition users.

e Documentation change: When setting up classes in VPORT, click the blue Kurzweil icon
in the last column to create a class, add grade and/or teacher details in the class name if
desired. Released documentation says “Select a grade-level by clicking on the desired
blue grade icon in the last column.”

STANDALONE AND NETWORK NOTES
Version 12 Standalone/Network Client Fixed Bugs
Brainstorm:
e Fixed Undo Paste operation, as well as a related bug where multi-step Undo would
result when multiple items were cut or deleted.
e Brainstorm items with multiple lines were not printing correctly; this has been fixed.
Zone Edit:
¢ File Exit while in Zone Edit resulted in the program hanging and required exiting Zone
Edit or choosing an action that changed the cursor state. This has been fixed.
e When in Zone Edit mode, the Scan feature should be disabled. The Start New Scan on
the Scan menu, however, was enabled. This has been fixed.

Scanning:
e Fixed file size increase when Show New Scans was enabled.
¢ Fixed Scan Repeatedly feature stopping after canceling a scan operation.
e Fixed inconsistent results when canceling a Scan operation.

Miscellaneous:
e When focus was in Column Notes, it was possible to create Bookmarks and Hyperlinks.
This has been fixed.
e When reading in Spanish, and the Syllables command was executed, the Pronounce
button and menu item became unavailable. This has been fixed.
e VoiceText voices couldn't be changed when reading MathML in Read the Web. This has
been fixed.

Kurzweil 3000 for Windows Release Notes Page 11 of 12
Version 12.18 05 July 2012



CONTACTING KURZWEIL EDUCATIONAL SYSTEMS

We welcome your comments, you can reach us using the following methods:

* By phone at 800-547-6747 (U.S. and Canada) or 303-651-2829 (all other countries)
* By e-mail at kurzweil3000support@kurzweiledu.com

* On the Web at http://www.kurzweiledu.com

* By mail at:

Cambium Learning Technologies

24 Prime Park Way, Suite 303

Natick, MA 01730

© 2012 Kurzweil Educational Systems, a Cambium Learning Technologies company. All Rights
Reserved.
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